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SAFETY PRECAUTIONS
(Read these precautions before using this product.)
Before using this product, please read this manual carefully and pay full attention to safety to handle the product correctly. If 
the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.
The precautions given in this manual are concerned with this product only.
In this manual, the safety precautions are classified into two levels: " WARNING" and " CAUTION".

Under some circumstances, failure to observe the precautions given under " CAUTION" may lead to serious 
consequences.
Observe the precautions of both levels because they are important for personal and system safety.
Make sure that the end users read this manual and then keep the manual in a safe place for future reference.

[Security Precautions]

WARNING
 To maintain the security (confidentiality, integrity, and availability) of the programmable controller and 

the system against unauthorized access, denial-of-service (DoS) attacks, computer viruses, and other 
cyberattacks from external devices via the network, take appropriate measures such as firewalls, 
virtual private networks (VPNs), and antivirus solutions.

WARNING Indicates that incorrect handling may cause hazardous conditions, resulting in 
death or severe injury. 

CAUTION Indicates that incorrect handling may cause hazardous conditions, resulting in 
minor or moderate injury or property damage.
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CONDITIONS OF USE FOR THE PRODUCT
(1) MELSEC programmable controller ("the PRODUCT") shall be used in conditions;

i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident;  
and 
ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the 
case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries.
MITSUBISHI ELECTRIC SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO 
ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT 
LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the 
PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY 
INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI ELECTRIC USER'S, INSTRUCTION 
AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT. 
("Prohibited Application")
Prohibited Applications include, but not limited to, the use of the PRODUCT in;
• Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the 

public could be affected if any problem or fault occurs in the PRODUCT.
• Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality 

assurance system is required by the Purchaser or End User.
• Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator, 

Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and 
Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other 
applications where there is a significant risk of injury to the public or property.

Notwithstanding the above restrictions, Mitsubishi Electric may in its sole discretion, authorize use of the PRODUCT in 
one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific 
applications agreed to by Mitsubishi Electric and provided further that no special quality assurance or fail-safe, 
redundant or other safety features which exceed the general specifications of the PRODUCTs are required. For details, 
please contact the Mitsubishi Electric representative in your region.

(3) Mitsubishi Electric shall have no responsibility or liability for any problems involving programmable controller trouble and 
system trouble caused by DoS attacks, unauthorized access, computer viruses, and other cyberattacks.



INTRODUCTION
Thank you for purchasing the FA integrated engineering software MELSOFT.
This manual describes the programming and functions required when using iQ AppPortal.
Before using this product, please read this manual carefully, and develop familiarity with the functions and performance of iQ 
AppPortal to handle the product correctly.
Note that the menu names and operating procedures may differ depending on an operating system in use and its version. 
When reading this manual, replace the names and procedures with the applicable ones as necessary.
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RELEVANT MANUALS

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated 
tool.
e-Manual has the following features:
 • Required information can be cross-searched in multiple manuals.
 • Other manuals can be accessed from the links in the manual.
 • Hardware specifications of each part can be found from the product figures.
 • Pages that users often browse can be bookmarked.
 • Sample programs can be copied to an engineering tool.

Manual name [manual number] Description Available form
iQ AppPortal Operating Manual
[SH-081623ENG] (this manual)

Functions and operation methods of iQ AppPortal e-Manual
PDF
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1 BEFORE USING THIS PRODUCT
iQ AppPortal is an integrated management tool for managing applications.
Assets such as project files of MELSOFT products and design documents that are managed in Windows Explorer can be 
saved for each application, and centrally managed in iQ AppPortal.
This can reduce person-hours for search and management.

1.1 System Overview
Assets (such as project files of MELSOFT products and design documents) registered and managed in iQ AppPortal are 
referred to as objects.
For using the system of iQ AppPortal, two personal computers are required: one as a server for saving master data (DB) of 
objects and the other as a client for operating objects in the screen of iQ AppPortal.
One personal computer can be used as both a server and a client.

DB

Server Client
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1.2 Features of iQ AppPortal
This section shows the features of iQ AppPortal for managing registered objects efficiently.

Simple registration
Objects can easily be registered in iQ AppPortal by dragging and dropping folders and files.
A folder for each application is automatically generated when registering a new object. Name the folder to manage.
Folders and files are saved to a server after registered in iQ AppPortal, then the history can be managed and data can be 
acquired.

Management for each application
In iQ AppPortal, folders are displayed for each application and objects in a folder are displayed in a layer structure.
The parent-child relationships of workspace files and project files of MELSOFT products are automatically determined by iQ 
AppPortal, and the files are displayed accordingly.
Information on folders and objects managed in iQ AppPortal can easily be checked in the feature information displayed in the 
callout property.
In addition, property information of folders and objects can be edited in the callout property and "Properties" screen.
Images can also be added to the property information.

DB

PDF
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Quick search
Target folders and objects can easily be searched for by refining them under the smart filter (type, register date, and date 
modified).
In addition, they can be searched for more quickly by using keywords for the property information and colored and named 
classifications.

Secure editing/saving of objects
In iQ AppPortal, the latest data of an object saved to a server can be edited securely by acquiring it in a work area separated 
from the save location.
Save the object to the server again after editing it in the work area.
The edit/management status of an object can be checked with the status displayed on it. (Page 29 Status display of an 
object)

Utilization of past data
When saving an added, edited, or deleted object to a server, the history is also saved.
From the history, the property information of the object can be browsed and past data can be acquired.
1  BEFORE USING THIS PRODUCT
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1.3 Object List
This section shows the objects that can be managed in iQ AppPortal.

Name in the manual Icon Description File format Extension
Workspace file of MELSOFT products MELSOFT Navigator workspace file  *.nvw

Compressed single file 
format

*.nvz

Project file of MELSOFT products GX Works3 project file  *.gx3

GX Works2 project file  *.gd2

Single file format *.gxw

Compressed file 
format

*.gwz

GX Developer project file  *.gpj

MT Developer2 project file (iQ-R series)  *.mtw

MT Developer2 project file (Q series)  *.mt2

Single file format *.mtw

Compressed file 
format

*.mtz

GT Designer3 (GOT2000) project file  *.gt32

Single file format *.gtx

Single file format 
(including a GOT 
operating system)

*.gtxs

GT Designer3 (GOT1000) project file  *.gt3

Single file format *.gtw

RT ToolBox3 workspace file*1  MELFA_WSP.xm
l*2

RT ToolBox2 workspace file*1  MELFA_WSP.xm
l*2

Simple Motion Module Setting project file  *.pmc

Single file format *.pcw

CW Configurator project file Single file format *.cp5

MR Configurator2 project file  *.mr2

Single file format *.mrc2

MR Configurator2 multiple axes system 
configuration project file

Single file format *.mrc2m

FR Configurator2 project file Single file format *.frc2

FR Configurator2 (Developer) project file Single file format *.fgw
1  BEFORE USING THIS PRODUCT
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*1 Managed together in each workspace.
*2 Used to determine an object.
*3 An extension name is displayed on each icon.

The icon color can be set for each extension. (Page 50 Setting the icon colors of objects)

Objects other than those of MELSOFT 
products*3

Differs for 
each 
extension.
(Example)

Other files FB libraries  *.mslm
*.mslu
*.usl
*.sul

Files other than the 
above

 *.pdf
*.xls
*.doc
etc.

Folder format object Folder containing other 
files registered as an 
object.
For details, refer to the 
following:
Page 79 Folder 
format object

 

Name in the manual Icon Description File format Extension
1  BEFORE USING THIS PRODUCT
1.3  Object List 11
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1.4 Learning Operation Methods of iQ AppPortal
This section explains the operation methods of iQ AppPortal.

Displaying the manual
Browse the manual to learn about operations and functions.

Operating procedure
Select the [Home] tab  the [Help] group  [Manual].
e-Manual Viewer starts and the manual appears.

Connecting to MITSUBISHI ELECTRIC FA Global Website
Open the MITSUBISHI ELECTRIC FA Global Website in a web browser.
Make sure your personal computer connect to the Internet in advance.

Operating procedure
Select the [Home] tab  the [Help] group  [Connect to MITSUBISHI ELECTRIC FA Global Website].

Checking the version of iQ AppPortal
Display information such as the software version of iQ AppPortal.

Operating procedure
Select the [Home] tab  the [Help] group  [Version Information].
1  BEFORE USING THIS PRODUCT
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2 SYSTEM CONFIGURATION
This chapter explains the system configuration of iQ AppPortal.
Folders and objects can be saved to a server in the screen of iQ AppPortal installed on a client.
For editing an object, acquire it from the server to a work area in the client and edit it in the work area. Then, save the edited 
object to the server again in the screen of iQ AppPortal, and the data in the server is updated.

System configuration Role
(1) Server • To store master data.

• To save past data and manage histories.

(2) Client • To select a server to connect to.
• To display information on objects saved to a server and those acquired in a work area on iQ AppPortal.
• To manage differences between an object in a work area and the corresponding one in a server.

(3) Work area • To acquire data from a server and edit it.

DB

(1)

(2) (3)
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3 SCREEN CONFIGURATION AND BASIC 
OPERATIONS

This chapter explains the screen configuration and basic operations of iQ AppPortal.

3.1 Start and End
This section explains the operation methods for starting and ending iQ AppPortal.

Start
Operating procedure

Start iQ AppPortal from "MELSOFT" in Windows Start.

End
Operating procedure

Select the [File] tab  [End].

3.2 Display Language Switching
iQ AppPortal supports multiple languages, and therefore the display language such as one on the menu can be switched on a 
personal computer.

Window
Select the [File] tab  [Switch Display Language].

Precautions
If the display language differs from the one for the operating system, displayed texts may get cut.
The language of feature information of MELSOFT products and entered characters cannot be switched.
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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3.3 Data Storage Destination/Work Area Setting
This section shows the "Data Storage Destination/Work Area Setting" screen for setting a data storage destination in a server 
and a work area in a client.

Window
Select the [File] tab  [Data Storage Destination/Work Area Setting].

Connection information (1) must be set so that a data storage destination (server IP address, port number, 
and repository) and a work area are on a 1:1 basis.

Operating procedure

Adding connection information and establishing a connection
1. Click the [Add Connection Information] button.
A row is added in "Connection Information List."

2. Set each item for "Server IP address," "Port No.," "Repository," and "Work Area."

3. Select the radio button (2), and click the [Connect] button.
The connection is established to a data storage destination containing the specified connection information.

Deleting connection information
1. Click the [Delete Connection Information] button.
Connection information is deleted.
However, the data in the repository is not deleted.
When deleting the connection information of a connected data storage destination, a new connection is established to the 
destination containing connection information in the first row.

Item Description
Server IP address The IP address of a data storage destination (MELSOFT iQ AppPortal (Server))

Port No. A port number used for VisualSVN Server 5.0.3 (Page 75 Server specifications for using iQ AppPortal)

Repository A data storage destination. It can be named to identify multiple repositories.
When installing iQ AppPortal, the default repository (iQAP) is generated as a data storage destination.
To add a repository, run the installer on a server. (Page 17 Adding a repository)

Work Area A local folder for editing data acquired from a repository

(2) (1)
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Adding a repository
A repository can be added by running the installer on a server after installing iQ AppPortal.

 • Up to 100 repositories can be created.
 • Data registered in iQ AppPortal with version earlier than Version 1.11M is stored in the repository (iQAP) 

generated when installing iQ AppPortal.
 • When adding a repository, also create a corresponding work area.
 • Before adding or deleting a repository, make sure that another client is not connected to a server.

Operating procedure
1. On a server, double-click "setup.exe" in the data obtained for installation.
Follow the on-screen instructions to add a repository.

The added repository can be selected in the "Data Storage Destination/Work Area Setting" screen.

2. Select the repository in the "Repository Setting" screen.
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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3.4 Option Setting
This section shows the "Option" screen for setting options such as "Basic Setting" for iQ AppPortal.

Window
Select the [File] tab  [Option].

Basic setting

User setting
A user name set under "User Setting" is displayed in the "Comment Input" screen when saving, and in "Comment" or "Author" 
in the "History" screen. (Page 26 Saving an object)(Page 52 History Management)

Object 1

Object filtering
Displaying deleted objects
Deleted folders and objects can be displayed on iQ AppPortal by selecting the checkbox of "Display the deleted object" under 
"Object Filtering." (Page 56 Deleted object acquisition)

Hiding read-only attribute folders
Read-only attribute folders can be hidden by unselecting the checkbox of "Display the read-only attribute folder." (Page 
84 Hiding read-only attribute folders)

Classification option
Displaying the names of classifications added to objects (at the time of list display)
The names of classifications added to folders and objects can be displayed in the object list area by selecting the checkbox of 
"Display the name of classification added to object. (At the time of list display)." (Page 41 Classification name display)

Callout property option
Enabling editing the callout property
Property information can be edited in the callout property by selecting the checkbox of "Enable Editing of Callout Property." 
(Page 30 Editing in the callout property)

Cache setting
Objects can be displayed in the screen more quickly by enabling the cache setting. (Page 49 Increasing the display 
speed in the object list area)
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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Object 2

Object icon display setting
The icon color of an object other than one of MELSOFT products can be set for each extension. (Page 50 Setting the icon 
colors of objects)

Register

Folder format object setting
A folder can be registered as a folder format object in iQ AppPortal by selecting "Maintain Folder Configuration and Register it 
as Folder Format Object." (Page 79 Folder format object)

Verify

External tool setting
A tool used to verify an object other than one of MELSOFT products can be set. (Page 87 Setting an external tool used 
for verification)

Restore work area
If an error such as 'failed to restore work area' occurs while operating iQ AppPortal, a work area must be restored in "Restore 
Work Area." (Page 48 Restoring a work area)
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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3.5 Screen Configuration
This section explains the screen configuration of iQ AppPortal.

Name Description
(1) Data storage destination/work area 

setting area
A server IP address and root set in the "Data Storage Destination/Work Area 
Setting" screen are displayed.
• : The server IP address and repository of a data storage destination
• : The root of a work area

Page 16 Data Storage 
Destination/Work Area 
Setting

(2) Smart filter area Folders and objects can be refined by selecting an item under "Type" or a period 
under "Register Date" or "Date Modified."

Page 32 Object Search

(3) Classification area Folders and objects can be searched for by selecting a classification.
Classifications are displayed for each classification type.

Page 35 Searching by a 
classification

(4) Free search box (classification) Classifications can be searched for by entering a keyword. Page 36 Classification search

(5) Object list area Folders and objects are tiled or listed.
The display format can be changed by the following operation:
• Select the [Home] tab  the [Display] group   or *1 

from the pull-down list.
In addition, folders and objects detected by searching for or refining are 
displayed.
If they are neither registered nor detected by searching for or refining, "No Data 
Exists" is displayed.



(6) Sort group The order of folders and objects displayed in the object list area can be 
selected.
• / : Select an order.
• : Select this to sort folders and objects in ascending order according to the 

selected item "Name" or "Date Modified."
• : Select this to sort folders and objects in descending order according to the 

selected item "Name" or "Date Modified."



(7) Free search box (folder/object) Folders and objects can be searched for by entering a keyword. Page 34 Searching by a 
keyword

(8) Folder Objects for each application are included. 

(9) Callout property The property information (model name, outline, image, etc.) of a folder and 
object is displayed.
If a MELSOFT iQ AppPortal information file (.iqap) is saved to a server, the 
feature information of a workspace file and project file of MELSOFT products is 
also displayed.
Property information can also be edited in the callout property.

Page 30 Editing in the callout 
property
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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*1 When selecting , the names of classifications added to folders and objects can be displayed. (Page 41 Classification name 
display)

(10) Application tree area Objects in a selected folder are displayed in a tree format.
The parent-child relationship of objects is automatically determined and the 
objects are displayed in a layer structure accordingly.



Name Description
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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3.6 Menu List
This section shows the menu list.

[File] tab
 [New] ( ) Page 23 New registration

 [Data Storage Destination/Work Area Setting] ( ) Page 16 Data Storage Destination/Work Area Setting

 [Switch Display Language] ( ) Page 15 Display Language Switching

 [Option] ( ) Page 18 Option Setting

 [End] ( ) Page 15 Start and End

[Home] tab
 [Edit] group ( )  [Copy] ( ) 

 [Paste] ( ) 

 [Delete Reservation] ( ) Page 27 Deleting an object

 [Work Area] group ( )  [Get the Latest Data] ( ) Page 42 Acquiring the latest data of an object in a work 
area

 [Solve the Data Conflict] ( ) Page 45 Solving an object conflict

 [Cancel the Change] ( ) Page 47 Canceling a change

 [Configuration Management] 
group ( )

 [Create Branch] ( ) Page 57 Creating a branch

 [Revision Graph] ( ) Page 58 Displaying a revision graph

 [Revision Graph [Selected Folder]] ( )

 [Classification] group ( )  [Classification Edit] ( ) Page 37 Classification edit

 [Sort] group ( )  Pull-down list ( / ) Page 20 Screen Configuration

 [Ascending order] ( )

 [Descending order] ( )

 [Display] group ( )  [Refresh] ( ) Page 28 Updating the display status

 [Properties] ( ) Page 31 Editing in the properties screen

 [History] ( ) Page 52 History Management

 Pull-down list ( / ) Page 20 Screen Configuration

 [Release Refine] ( ) Page 41 Releasing refinement

 [Verify] group ( )  [Verify between Objects] ( ) Page 64 Verifying two objects

 [Verify with the Latest Data] ( ) Page 66 Verifying with the latest data

 [Data Operation] group ( )  [Import] ( ) Page 69 Importing objects

 [Export] ( ) Page 71 Exporting objects

 [Help] group ( )  [Manual] ( ) Page 12 Displaying the manual

 [Connect to MITSUBISHI ELECTRIC FA Global Website] 
( )

Page 12 Connecting to MITSUBISHI ELECTRIC FA Global 
Website

 [Version Information] ( ) Page 12 Checking the version of iQ AppPortal
3  SCREEN CONFIGURATION AND BASIC OPERATIONS
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4 OBJECT MANAGEMENT
This chapter explains the methods for managing objects by using iQ AppPortal.

4.1 Object Registration/Save/Deletion
This section explains the basic operations of iQ AppPortal such as registering, saving, and deleting an object.

Registering an object
In iQ AppPortal, an object is managed in a folder for each application.
When registering an object, a folder for each application is created in the object list area.

New registration
An object can be registered by dragging and dropping a folder or file onto the object list area.
The parent-child relationship of files in a folder is automatically determined by iQ AppPortal and the files are displayed in a 
layer structure accordingly.
There are two selectable methods for registering a folder. For details, refer to the following:
Page 79 Folder format object

Operating procedure
1. Drag and drop a folder or file onto the object list area.

2. Enter a folder name.

 • If multiple folders or files with the same name are included in the same layer in a folder, the folder cannot be 
registered. In this case, register it as a folder format object. (Page 79 Folder format object)

 • Hidden files and folders included in a folder are also registered at the same time.

 • Folders and objects registered in iQ AppPortal are saved to a server by clicking the [Save] button, and 
copied to a work area at the same time. (Page 26 Saving an object)

 • Up to 200 objects can be registered in one folder, and up to 10,000 folders and objects can be saved to a 
server in total.
4  OBJECT MANAGEMENT
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When registering a workspace or project that consists of multiple files
It can be registered in iQ AppPortal by compressing it into a single file format (.zip, etc.).
Workspaces and projects other than the following must be compressed into a single file format (.zip, etc.).

Workspace file (workspace format)

• MELSOFT Navigator

• RT ToolBox3

• RT ToolBox2

Project file (workspace format)

• GX Works3

• GX Works2

• GX Developer

• MT Developer2

• GT Designer3

• Simple Motion Module Setting

• MR Configurator2
4  OBJECT MANAGEMENT
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Additional registration/update
An additional object can be registered by dragging and dropping a folder or file onto a folder in the object list area or onto the 
application tree area.
If the name and type of a dragged and dropped file are the same as those of a registered object and the file and object are 
determined to be in the same layer by iQ AppPortal, the object is updated.
There are two selectable methods for registering a folder. For details, refer to the following:
Page 79 Folder format object

When dragging and dropping a file onto a folder in the object list area
An object is added to the folder.
If the object is a workspace file or project file of MELSOFT products, it is automatically displayed in a layer determined by iQ 
AppPortal.

When dragging and dropping a file onto the application tree area
An object can be freely added to any layer in the application tree area.
However, rules such as a layer placement relationship and parent-child relationship apply to the object. (Page 78 Object 
configuration rules)

When re-registering a workspace file or project file edited in a MELSOFT product, a message appears if the 
update date and time is different between the MELSOFT iQ AppPortal information file (.iqap) and the 
workspace file or project file.
If the message appears, save the workspace file or project file again in a MELSOFT product that supports 
MELSOFT iQ AppPortal information files (.iqap), then re-register it.

Precautions
 • If a project file is moved from the workspace tree of MELSOFT Navigator in the application tree area, it is deleted from the 

workspace managed in MELSOFT Navigator.
 • When adding a project file to a workspace managed in MELSOFT Navigator in the application tree area, register it in a 

workspace format. If registered in a single file format, it is not displayed in the workspace tree of MELSOFT Navigator.
4  OBJECT MANAGEMENT
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Saving an object
A folder and object registered in iQ AppPortal can be saved to a server by clicking the [Save] button.
A comment entered in the "Comment Input" screen is displayed in "Comment" in the "History" screen. (Page 52 History 
Management)

Operating procedure
1. Click the [Save] button in the application tree area.

2. Enter a comment.

 • For saving a folder and object in the application tree area, the following operation is also available:
⋅ Right-click it and select [Save the Selected Object] from the shortcut menu.
 • When saving multiple objects at the same time, there may be the following cases:
⋅ A comment entered when saving them is displayed in "Comment" of all of them.
⋅ If there is even one conflicting object in a folder, the objects cannot be saved. Solve the data conflict, then 
save them again. (Page 45 Solving an object conflict)
 • Up to 2,000 characters can be entered in a comment. A line feed is counted as two characters.

Precautions
Check that the overlay icon is  (Normal) after saving an object. If it is not Normal, the object is not saved properly. Save it 
again after removing the cause. (Page 29 Status display of an object)
4  OBJECT MANAGEMENT
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Deleting an object
Data saved to a server can be deleted.
When deleting data in a server, the corresponding folder or object acquired in a work area is also deleted at the same time.

Operating procedure
1. Select the [Home] tab  the [Edit] group  [Delete Reservation].
The overlay icon changes to  (Delete Reservation). (Page 29 Status display of an object)

2. Click the [Save] button. (Page 26 Saving an object)

Precautions
When deleting a folder and object, all objects in their lower layers are also deleted at the same time.
In addition, its property information is deleted at the same time.

GX Works3 Sample 

Data1.iqap

GX Works3 Sample 

Data1.iqap

Vol11_Cart_PLC

.gx3

Vol11_Cart_PLC

.gx3.iqap
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4.2 Object Information Edit
This section shows the details on editing object information registered in iQ AppPortal.

Updating the display status
The statuses of a folder and object displayed on iQ AppPortal can be updated as necessary after comparing data saved to a 
server with an object acquired in a work area.

Operating procedure
Select the [Home] tab  the [Display] group  [Refresh].

If neither folder in the object list area nor object in the application tree area is selected, the displays of all 
folders and objects are updated.
Even when an error occurs in a selected folder or object, the displays of all folders and objects other than the 
selected one are updated.

DB
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Status display of an object
The status of an object is displayed with an overlay icon.
The object status indicates the difference between data saved to a server and an object acquired in a work area.

The overlay icon is not displayed on a read-only attribute folder because an object in the read-only attribute 
folder cannot be edited.
For details on read-only attribute folders, refer to the following:
Page 83 Read-only attribute folders

If several object statuses exist in a folder
The object statuses of all objects in the folder are determined and the overlay icon of the folder is displayed accordingly.

Ex.

If several object statuses exist, the overlay icon of a folder is displayed as follows:
 • The Conflict overlay icon is displayed on the folder if the folder contains a conflicting object.
 • The Change overlay icon is displayed on the folder if the folder contains objects that are changed, reserved for deletion, or 

added.
 • The overlay icon is displayed in the order of Past Version Data, not acquired, and Normal if an object in the folder is past 

version data, not acquired, or normal.

If several object statuses exist in objects in the parent-child relationship
The object status of the lower layer is also displayed on the object in the upper layer.
The object status displayed on an object in the upper layer is displayed in the same priority order as a folder.
However, if there is no change in an object in the upper layer when an object status in the lower layer changes, the edit history 
of the object in the upper layer is not saved.

If an overlay icon is not updated
When caching is enabled, an overlay icon may not be updated. In this case, select the folder to update it.
To update all overlay icons, refresh the cache.
For details, refer to the following:
Page 49 Increasing the display speed in the object list area

If a MELSOFT iQ AppPortal information file (.iqap) in a work area is old

If a MELSOFT iQ AppPortal information file (.iqap) in a work area is older than the corresponding one in a server, the icon 
indicating that the file is old is displayed.
To match the file between the work area and the server, acquire the latest data.

Overlay icon Object status Status of an object
Conflict While editing an object in a work area, the corresponding data in a server is updated by another 

user.

Change An object in a work area is newer than the corresponding data in a server.

Delete Reservation Data in a server is reserved for deletion (not saved).

Add Data is added to a server, or a file is added to a work area (not saved).

Past Version Data An object in a work area is older than the corresponding data in a server.

(N/A) Not acquired No object is acquired in a work area.

Normal There is no difference between an object in a work area and the corresponding data in a server.

Priority order 1 2 3 4 5 6 7
Object status Conflict Change Delete 

Reservation
Add Past Version 

Data
Not acquired Normal
4  OBJECT MANAGEMENT
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Editing property information
Property information of folders and objects can be edited in the callout property and "Properties" screen.

Editing in the callout property

Window
Select the [File] tab  [Option]  "Object 1."

Operating procedure
1. Select the checkbox of "Enable Editing of Callout Property" under "Callout Property Option" in the "Option" screen.

2. In the "Display Item" list, select the checkboxes of items to display in the callout property, and click the [OK] button.
The items with their checkboxes selected are displayed in the callout property. ("Name" is always displayed.)

3. Enter property information in the callout property, and click the [Save] button.

 • The contents of "Name," "Model Name," "Outline," "Author," and "Remark" can be edited.
 • An image file can be added to "Image." (Page 31 Image registration)
 • A classification added to the object in the "Classification Edit" screen is displayed in "Classification." 

(Page 40 Classification addition)

Property information cannot be edited in the following cases:
 • A read-only attribute folder is selected.
 • A deleted object is selected.
 • An object is selected when its overlay icon is  (Conflict),  (Delete Reservation), or  (Past Version 

Data).
 • The "Properties" screen of an object with its callout property displayed is open.
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Editing in the properties screen

Window
Click the [Properties] button in the callout property.

Operating procedure
Enter property information, and click the [Save] button.

 • The contents of "Name," "Model Name," "Outline," "Author," and "Remark" can be edited.
 • An image file can be added to "Image." (Page 31 Image registration)
 • A classification added to the object in the "Classification Edit" screen is displayed in "Classification." 

(Page 40 Classification addition)

Property information cannot be edited in the following cases:
 • A read-only attribute folder is selected.
 • A deleted object is selected.
 • An object is selected when its overlay icon is  (Conflict),  (Delete Reservation), or  (Past Version 

Data).

Image registration
An image can be registered in the property information of a folder and object.
The registered image is displayed in the callout property and in "Image" in the "Properties" screen.

Operating procedure
Click the [+] button at the bottom right of "Image" to select an image file.

File types and sizes which can be registered in "Image"
An image file (.bmp, .jpg, .jpeg, .gif, .tif, .tiff, .png, etc.) can be registered in "Image."
A size which can be registered is less than 5 MB per image file.
4  OBJECT MANAGEMENT
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4.3 Object Search
This section shows the details on quickly searching for folders and objects registered in iQ AppPortal by using the smart filter 
area, free search box (folder/object), or classification area.
 • In the smart filter area, folders and objects can be refined under "Type," "Register Date," or "Date Modified."
 • In the free search box (folder/object), folders and objects can be searched for by entering a keyword included in their 

property information.
 • In the classification area, folders and objects with classifications added can be searched for.
Found folders and objects are displayed in the object list area.

A condition specified for a search is retained even after ending iQ AppPortal.
When starting it next time, the object list area will be displayed with a condition specified for the previous 
search retained.
4  OBJECT MANAGEMENT
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Refining under the smart filter
In the smart filter area, folders and objects can be refined by specifying an item under "Type" or a period under "Register 
Date" or "Date Modified."

The display in the smart filter area is updated by clicking the [Get the Latest Data] button in the application 
tree area.

Operating procedure
 • Select the checkbox of the type of an object under "Type."
 • Specify a period under "Register Date" or "Date Modified."
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Objects that can be refined by the type
The following shows the objects that can be refined by the type.

Searching by a keyword
Folders and objects can be searched for by entering a keyword included in their property information in the free search box 
(folder/object).

For searching by a keyword, characters are case-sensitive.
When entering multiple keywords delimited by spaces, objects including the keywords can be searched for.

Operating procedure
Enter a keyword in the free search box (folder/object).

Workspace file

• MELSOFT Navigator

Project file

• GX Works3

• GX Works2

• GX Developer

• MT Developer2

• GT Designer3

• RT ToolBox3

• RT ToolBox2

• Simple Motion Module Setting

• CW Configurator

• MR Configurator2

• FR Configurator2
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Searching by a classification
In the classification area, folders and objects with classifications added can be searched for.

Operating procedure
1. Select "AND" or "OR" in "Search Method" in the classification area.

2. Select the checkbox of a classification for a search.

For searching for folders and objects in the classification area, the following operations must be performed in 
advance:
 • Create a colored and named classification in the "Classification Edit" screen. (Page 37 Classification 

edit)
 • Assign a classification type to a classification in the "Classification Edit" screen. (Page 37 Assigning a 

classification type)
 • Add a classification to a folder and object. (Page 40 Classification addition)
4  OBJECT MANAGEMENT
4.3  Object Search 35



36
Classification search
Classifications can be searched for by entering a keyword in the free search box (classification).

For searching by a keyword, characters are case-sensitive.
When entering multiple keywords delimited by spaces, classifications including the keywords can be searched for.

Operating procedure
Enter a keyword in the free search box (classification).

Search condition clearing
All search conditions for classifications can be cleared by clicking the  icon in the classification area.
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Classification edit
A classification can be edited (added/changed/deleted) in the "Classification Edit" screen.
In addition, a classification type can be assigned to a classification.
Up to 5000 classifications can be created.

Window
Click the  icon in the classification area.

Operating procedure

Adding a classification
1. Click the [New] button.

2. Enter a classification name.

Changing a classification name
1. Perform either of the following operations:
 • Double-click a classification name.
 • Select a classification to change its name, and click the [Rename] button.

2. Enter a classification name.

Changing a classification color
1. Select a classification to change its color.

2. Select a color from the pull-down list of .

Assigning a classification type
Select a classification type to assign from the pull-down list in the "Classification Type" column.
For the setting method of a classification type, refer to the following:
Page 38 Classification type setting

Setting the display position for each classification
In the "Classification Display Position Setting" screen, set the display position for each classification in the object list area and 
application tree area.
For details, refer to the following:
Page 39 Display position setting for each classification
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Deleting a classification
1. Select a classification to delete.

2. Click the [Delete] button.

Classification type setting
A classification type can be set in the "Classification Type Setting" screen.
The set classification type can be assigned to a classification. (Page 37 Assigning a classification type)
Up to four classification types can be set.

Window
Click the [Classification Type Setting] button in the "Classification Edit" screen.

Operating procedure
1. Enter a classification type name.

2. Click the [OK] button.
The set classification type is applied to the "Classification Type" column in the "Classification Edit" screen.

In the "Properties" screen, classifications are displayed in numerical order (No.1 to No.4) of the classification 
types in the "Classification Type Setting" screen.
(Example) For the following combinations:
 • Classification type No.1: Customer, Classification: Company A
 • Classification type No.2: Equipment, Classification: Equipment B
 • Classification type No.3: Function, Classification: Function C
 • Classification type No.4: Project, Classification: Project D
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Display position setting for each classification
The display position for each classification in the object list area, application tree area, and revision graph can be set in the 
"Classification Display Position Setting" screen.
Set the display position of a classification for each classification type.

Window
Click the [Classification Display Position Setting] button in the "Classification Edit" screen.

Operating procedure
1. Set a classification type in the "Display Position Setting" field for each number displayed in the "Display Position 

Description" field.

2. Click the [OK] button.

3. Click the [OK] button in the "Classification Edit" screen.
Classifications are displayed in the set display positions.
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Classification addition
A selected classification can be added to a folder and object.

Operating procedure

In the classification area
Select a classification, and drag and drop it onto a folder and object.

In the "Classification Edit" screen
1. Select a folder and object, and select the [Home] tab  the [Classification] group  [Classification Edit].
The checkboxes of classifications are displayed in the "Classification Edit" screen.

2. Select the checkboxes of classifications, and click the [OK] button.

Up to 20 classifications can be added to one folder or object.

Classification cancellation
An added classification can be canceled by unselecting the checkbox in the "Classification Edit" screen.
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Classification name display
The names of classifications added to folders and objects can be displayed when listing the folders and objects in the object 
list area.

Window
Select the [File] tab  [Option]  "Object 1."

Operating procedure
Select the checkbox of "Display the name of classification added to object. (At the time of list display)," and click the [OK] 
button.

Releasing refinement
The display in the object list area and classification area can be returned to the state before searching.

Operating procedure
Select the [Home] tab  the [Display] group  [Release Refine].
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4.4 Object Utilization
This section shows the details on editing an object registered in iQ AppPortal by acquiring the corresponding data from a 
server to a work area.
The edited object must be saved to the server after updating the display status in iQ AppPortal.

Acquiring the latest data of an object in a work area
The latest data of an object to be edited (including objects in its lower layer) can be acquired from a server to a work area.

A work area can be set in the "Data Storage Destination/Work Area Setting" screen. (Page 16 Data Storage Destination/
Work Area Setting)

Operating procedure
Click the [Get the Latest Data] button in the application tree area.

DB
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Editing an object
An object acquired in a work area can be edited.

Operating procedure
To edit an object acquired in a work area, start a tool for editing in iQ AppPortal by either of the following operations:
 • Double-click an object.
 • Right-click an object and select [Open From Program] from the shortcut menu.

If the overlay icon is  (Conflict) or  (Add), or no object is acquired, a tool for editing does not start.
In addition, it does not start if not installed on the operating system.

If a tool for editing does not start in iQ AppPortal
Edit an object by the following procedure:

1. Open the place of an object by either of the following operations:
 • Right-click an object and select [Open the Place of Object] from the shortcut menu.
 • Click the root ( ) in the data storage destination/work area setting area.

2. Start the tool for editing and edit the object.
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Saving an edited object again
An edited object must be saved to a server again.

Operating procedure
1. Select the [Home] tab  the [Display] group  [Refresh]. (Page 28 Updating the display status)
The overlay icon changes to  (Change). (Page 29 Status display of an object)

2. Click the [Save] button. (Page 26 Saving an object)

 • Even when changing a folder or file name in a work area, the corresponding folder or object saved to a 
server is not updated. The changed one is registered as a new folder or object.

 • To re-register a folder and file duplicated outside a work area in iQ AppPortal, drag and drop a folder for 
each application onto iQ AppPortal.
For the folder configuration, refer to the following: (Page 85 Folder configuration in a work area)

DB
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Solving an object conflict
When saving an object edited in a work area to a server, its overlay icon changes to  (Conflict) if the corresponding data in 
the server is updated by another user.
If the overlay icon is  (Conflict), the state must be solved.

Operating procedure

(1) Solving the conflict by overwriting the data in the data storage destination with the object 
in the work area

1. Select the [Home] tab  the [Work Area] group  [Solve the Data Conflict].

2. Select "Overwrite and register it with the object of work area."
 • The data in the server (edited by another user) can be overwritten with the object in the work area (being edited).
 • The overlay icon changes to  (Change).

3. Acquire past data (edited by another user) from the history, and merge the changes in the data into the object.

4. Click the [Save] button. (Page 26 Saving an object)

(1) Solving the conflict by overwriting the data in the data storage destination with the object in the work area
(2) Solving the conflict by updating the object in the work area with the data in the data storage destination

(1)

(2)
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(2) Solving the conflict by updating the object in the work area with the data in the data 
storage destination

An object being edited in a work area is updated with data edited by another user.
Save data being edited outside the work area in advance.

1. Select the [Home] tab  the [Work Area] group  [Solve the Data Conflict].

2. Select "Update the work area in the object of the data storage destination (Discard the edit data of work area)."
 • The object in the work area (being edited) is deleted, and the latest data (edited by another user) is acquired from the 

server in the work area.
 • The overlay icon changes to  (Normal).

3. Merge the changes in the object that was being edited into the object in the work area (data edited by another user).

4. Click the [Save] button. (Page 26 Saving an object)
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Canceling a change
A change in an object can be canceled unless the object is saved to a server.
 • An object edited in a work area will be the latest data saved to a server.
 • An object operated (moved/reserved for deletion) in iQ AppPortal returns to the state before the operation.
 • The overlay icons such as  (Conflict),  (Delete Reservation),  (Change), and  (Add) return to  (Normal).

When a change is canceled, the change for the lower layer is also canceled.

Operating procedure
Select the [Home] tab  the [Work Area] group  [Cancel the Change].

Precautions
If data in a server is updated by another user before canceling a change, the updated data is acquired in a work area.
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Restoring a work area
If an error such as 'failed to restore work area' occurs while operating iQ AppPortal, a work area must be restored in "Restore 
Work Area."
Inconsistency between data in a server and an object in a work area can be solved by restoring the work area.

Ex.

If the status is inconsistent between data in a server and an object in a work area
Data in the server is saved but the object in the work area is not saved in iQ AppPortal.

Window
Select the [File] tab  [Option]  "Restore Work Area."

Operating procedure
Click the [Restore Work Area] button.
4  OBJECT MANAGEMENT
4.4  Object Utilization



4

Increasing the display speed in the object list area
The display speed in the object list area can be increased by saving the status of an object to the cache (temporary file) and 
using it when updating the display to reduce the number of times of communication with a server.

Window
Select the [File] tab  [Option]  "Object 1."

Operating procedure
Select "Enable Cache" under "Cache Setting," and click the [OK] button.

Operation when caching is enabled
When caching is enabled, an overlay icon may not be updated. In this case, select the folder to update it.
To update the overlay icons of all folders, click the [Cache Refresh] button.
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Setting the icon colors of objects
The icon color of an object other than one of MELSOFT products can be set for each extension.
It is white if no color is set for an extension.

Precautions
Colors are set by default for some extensions.
Only the colors can be changed from the default settings; the extension names cannot be changed and the settings 
themselves cannot be deleted.

Window
Select the [File] tab  [Option]  "Object 2."

Operating procedure

Creating a new setting
1. Click the [New] button.
A row is added in the list.

2. Select a color from the pull-down list of .

3. Enter an extension name in the "Extension" column, and click the [OK] button. (Up to 32 characters)

Changing an extension name
1. Perform either of the following operations:
 • Double-click an extension name.
 • Select a setting to change its extension name, and click the [Change Extension] button.

2. Enter an extension name in the "Extension" column, and click the [OK] button. (Up to 32 characters)

(1): Default settings
(2): Newly created settings
(3): If no color is set for the extension
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Changing a color
1. Select a setting to change its color.

2. Select a color from the pull-down list of .

3. Click the [OK] button.

Deleting a setting
1. Select a setting to delete.

2. Click the [Delete] button.

3. Click the [OK] button.

Restoring colors to their defaults
1. Click the [Restore the Default Settings] button.
Only the icon colors set by default return to their defaults.

2. Click the [OK] button.
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4.5 History Management
This section shows the details on managing data, a saved comment, and the property information when performing each 
operation (add/change/delete) for an object as histories in a server via iQ AppPortal.

Precautions
An operation (add/change/delete) for an object is managed as a history but the following operations are not saved as 
histories:
 • Changing a property
 • Editing or adding a classification
When performing a same operation (add/delete) for an object, only the latest operation is saved as a history.

Checking a change history of an object
The history list of an object and a comment entered when saving the object to a server can be checked in the "History" 
screen.

Window
Select the [Home] tab  the [Display] group  [History].
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Details when editing an object are displayed in "Revision," "Action" (add/change/delete), and "Date" under "History List."
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Acquiring past data of an object from the history
Past data of an object can be acquired from "History List."

Operating procedure
1. Select a history from "History List" in the "History" screen.

2. Click the [Acquire the selected data] button.

3. Specify an output destination for the selected past data of the object.

To prevent data from being overwritten, a folder different from one in a work area must be specified as the 
output destination for past data of an object.

Precautions
The history of acquired past data of an object is not retained. It is treated in the same way as new registration when re-
registering it after editing.
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Browsing/acquiring a deleted object
Data of a deleted object can be acquired in the history screen after displaying the deleted object.

Deleted object display
A deleted folder and object can be displayed by setting an option.

Window
Select the [File] tab  [Option]  "Object 1."

Operating procedure
Select the checkbox of "Display the deleted object" under "Object Filtering," and click the [OK] button.
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Deleted object acquisition
Past data of an object can be acquired in the "History" screen of the deleted object.

Operating procedure
1. Select a deleted object, and select [History] in the [Home] tab  the [Display] group.

2. Select a history under "History List" in the "History" screen, and click the [Acquire the selected data] button.

3. Specify an output destination for the selected past data of the object.

Precautions
The history of acquired past data of an object is not retained. It is treated in the same way as new registration when re-
registering it after editing.
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4.6 Branch Management
This section shows the details on branches created when utilizing folders saved to a server.
A folder duplicated by creating a branch can be customized independently from its source folder.
The relationship between a duplicated branch and its source folder is displayed in a tree structure in the revision graph. This 
enables visual management.

Creating a branch
To create a branch from the latest folder, select a folder on iQ AppPortal.

Operating procedure
1. Select the [Home] tab  the [Configuration Management] group  [Create Branch].

2. Click the [Save] button. (Page 26 Saving an object)
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Displaying a revision graph
A revision graph is a graph for displaying revisions of folders related to a selected folder in a tree structure.
Only revisions of a selected folder can also be displayed.
A revision graph can be displayed in the following screens:
 • "Revision Graph" screen: Revisions of folders related to a selected folder are displayed.
 • "Revision Graph [Selected Folder]" screen: Only revisions of a selected folder are displayed.
In addition to the revision graph, the history list and revision details are also displayed in these screens. (Page 63 
Revision refinement)

The selected folder is displayed in bold.
A deleted folder is displayed in gray.
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Operating procedure
1. Select a folder in the object list area or application tree area.

2. Select the [Home] tab  the [Configuration Management] group  [Revision Graph] or [Revision Graph [Selected 
Folder]].

By classifying folders for each purpose, they can easily be found when displaying the revision graph.
Page 32 Object Search
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Tree structure display switching
The display of a tree structure can be switched by clicking  (display upper and lower folders only) or  (display all 
folders) to the right of "Switch Display."
This operation is available in the "Revision Graph" screen only.

When displaying only upper and lower folders of a selected folder in a tree
 (Display upper and lower folders only)

A branch source folder is an upper one, and a folder duplicated from a selected folder is a lower one.

 Range of upper and lower folders

When displaying all folders related to a selected folder in a tree
 (Display all folders)

Solution Solution1 Solution1-1

Solution2 Solution2-1

Solution2-2

212

2020/9/11

213

215 216

217

214
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Layer display switching
The display of a selected folder can be switched for each layer by clicking  (Open All Layers) or  (Close All Layers) to 
the right of "Layer."
In addition, lower folders of a selected folder can be expanded and collapsed by clicking  (expand the layer) at the bottom 
left of the folder.
These operations are available in the "Revision Graph" screen only.

When opening all layers
 (Open All Layers)

When closing all layers
 (Close All Layers)

When expanding and collapsing lower folders of a selected folder
 (Expand the layer)
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Display of objects in a selected folder
Objects in a selected folder can be displayed in the application tree area.
This operation is available in the "Revision Graph" screen only.

Operating procedure
Click the [Display Objects in Folder] button.

Revision details display
A comment when saving or the list of changed objects of a selected folder can be displayed.

Operating procedure
Click the [Display Revision Details] button.

Branch creation
A duplicate of a selected folder can be created.

Operating procedure
1. Click the [Create Branch] button.

2. Enter a folder name.

3. Click the [Save] button. (Page 26 Saving an object)
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Revision refinement
Revisions displayed under "History List" can be refined by entering a keyword in the free search box.
Information entered when saving a changed object to a server is displayed in "Comment" under "History List." This enables 
quick search of a target revision.
In addition, only objects changed in a selected revision are displayed in "Change Object List." This enables a target object to 
easily be found.

Operating procedure
Enter a keyword in the free search box.

Displayed items

No. Item Description
(1) [<]/[>] button Click either of these to display or hide "History List" and "Revision Details."

(2) Free search box Revisions can be refined according to the contents in "Date," "Folder Name," and "Comment" by entering a 
keyword.
Characters are case-sensitive.
When entering multiple keywords delimited by spaces, revisions including the keywords can be refined.

(3) [Save History List] button Click this to output the content displayed under "History List" to a file in CSV format.

(4) Display Change Object List Unselect the checkbox to hide the change object list.

(5) Change Object List Only changed objects are displayed.
They are displayed in order from read ones.
Double-click a displayed object to open. When opening and editing it, save it with a name.
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4.7 Verification
This section shows the details on verifying an object to check changes in the object.

Target objects
The following table shows the objects to be verified.
For verification, a tool supporting a target object must be installed.

*1 For the supported versions, refer to the following:
Page 86 Versions of MELSOFT products used for verification

Verifying two objects
Two objects, which are selected in the object list area, application tree area, "History" screen, "Revision Graph" screen, 
"Revision Graph [Selected Folder]" screen, and "Revision Verification Result" screen, can be verified.

Objects can be verified even if their names are different.
In addition, objects displayed in different screens can be verified.

Object Tool
GX Works3 project file GX Works3*1

GX Works2 project file GX Works2*1

GT Designer3 (GOT2000) project file GT Designer3*1

Objects other than those of MELSOFT products A set external tool.
For the setting method, refer to the following:
Page 87 Setting an external tool used for verification
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Operating procedure
1. Select an object or revision in any of the following:
 • Object list area
 • Application tree area
 • "History" screen
 • "Revision Graph" screen
 • "Revision Graph [Selected Folder]" screen
 • "Revision Verification Result" screen

2. Right-click the selected one, and select [Select as Verify Source] or [Select as Verify Destination] from the shortcut 
menu.*1

The "Verify between Objects" screen appears, and the corresponding object is displayed in "Verify Source" or "Verify 
Destination."

3. Repeat steps 1 and 2 to set objects for "Verify Source" and "Verify Destination" in the "Verify between Objects" screen.

4. Click the [Verify] button.
The verification result is displayed in a tool supporting the object.
*1 When selecting a changed object in the "Revision Verification Result" screen, specify the revision number of a verification source or 

verification destination.

To display the "Verify between Objects" screen before selecting an object or a revision, select the following 
menu:
 • [Home] tab  [Verify] group  [Verify between Objects]
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Verifying with the latest data
Data in a work area can be verified with the latest data in a server.

Changes in an object can be checked when its overlay icon is  (Conflict),  (Change), or  (Past 
Version Data).
Note that all items may be determined to match in a verification result in the following cases:
 • Only information not to be verified is changed in an object (example: comments of a GX Works3 project, 

etc.).
 • A project is overwritten without being edited.
For information on verification targets of GX Works3, GX Works2, and GT Designer3 project files, refer to the 
manual for each tool.

Operating procedure
1. Select an object in the application tree area.

2. Select the [Home] tab  the [Verify] group  [Verify with the Latest Data].
The verification result is displayed in a tool supporting the object.
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Verifying two revisions in the history list
Two revisions can be verified under "History List."

Changes between revisions more detailed than the comment can be checked.

Operating procedure
Select an object in the application tree area, and display its history. (Page 52 History Management)

1. Click the revision (1) for a verification source.

2. Click the revision (2) for a verification destination with the  key held down.

3. Click the [Verify between Revisions] button.
The verification result is displayed in a tool supporting the object.

(1)

(2)
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Verifying an object in two revisions in the revision graph
An object between revisions can be verified in the "Revision Graph" and "Revision Graph [Selected Folder]" screens.

Changes in a folder duplicated by creating a branch and those in an object changed between revisions can be 
checked.

Operating procedure
Select a folder in the object list area, and display its revision graph. (Page 58 Displaying a revision graph)

1. Click the revision (1) for a verification source.

2. Click the revision (2) for a verification destination with the  key held down.

3. Click the [Verify between Revisions] button.
The revision verification result is displayed.

4. Double-click a changed object in "Change Object List."
The verification result is displayed in a tool supporting the object.

Item Description
Verify Source The folder information of a verification source is displayed.

Verify Destination The folder information of a verification destination is displayed.

Change Object List Changed, added, or deleted objects are listed.
They are displayed in order from read ones.

(1)

(2)

(1)

(2)
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4.8 Import and Export of Objects
This section shows the details on importing or exporting multiple folders and objects to register or output them in a batch.
These operations enable efficient work when handling multiple folders, such as for the operation start of iQ AppPortal or 
server migration.

Importing objects
Multiple folders and objects can be registered in iQ AppPortal and saved to a server in a batch.
There are two selectable methods for registering folders. For details, refer to the following:
Page 79 Folder format object

Window
Select the [Home] tab  the [Data Operation] group  [Import].

Operating procedure
1. Specify the path to a folder to register by either of the following operations:

Click the [Browse] button to specify a folder, or enter the path directly under "Path."*1

2. Click the [Read] button.

3. Select the checkbox of a folder to register.

4. Click the [Import] button.
*1 Specify a folder in the one-level upper layer.

By right-clicking a folder or object in the import list and selecting [Open the Place of Object] from the shortcut 
menu, the corresponding folder opens in Windows Explorer.
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Folder configuration that cannot be imported
An error occurs and a folder does not appear under "Import List" in the following cases:

If the layer structure is incorrect
If the layer structure of an object in a folder is incorrect, an error occurs.
For the layer structure of an object, refer to the following:
Page 78 Object configuration rules

If an object with the same name exists
According to the object configuration rules, all objects other than those of MELSOFT products are placed as other files in the 
second layer immediately under a folder.
As a result, if another object with the same name already exists in the second layer, an error occurs.
For the object configuration rules, refer to the following:
Page 78 Object configuration rules

If a folder cannot be accessed
If a user does not have the access right to a folder, an error occurs.

Precautions
Neither object nor property can be saved to a server from another client during import.
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Exporting objects
Data saved to a server can be output to a folder in a batch.

Window
Select the [Home] tab  the [Data Operation] group  [Export].

Operating procedure
1. Specify the path to a folder to output by either of the following operations:

Click the [Browse] button to specify a folder, or enter the path directly under "Path."

2. Select the checkbox of a folder to output under "Export List."

3. When exporting a MELSOFT iQ AppPortal information file (.iqap), select the checkbox of "Export the information file."
By exporting a MELSOFT iQ AppPortal information file (.iqap), the property information can be retained when saving the 
folder to another server.

4. Click the [Export] button.

If objects displayed in the object list area are refined by a keyword, the smart filter, or classification, the 
condition is applied to "Export List."
To change the condition, close the "Export" screen once, change the condition, and then open the "Export" 
screen again.

Precautions
The following types of folders do not appear under "Export List."
 • Read-only attribute folder
 • Folder with the object status of Add
 • Folder added by another client after opening the "Export" screen
4  OBJECT MANAGEMENT
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APPENDIX
Appendix 1 Additions and Changes from Previous 

Version
This section shows the additions and changes with upgrade.

Version 1.01B

Version 1.04E

Version 1.07H

Version 1.11M

Item Description Reference
 The folder configuration in a work area is changed. Page 89 Update from iQ AppPortal Version 

1.00A

Item Description Reference
Creating a branch Branches can be created based on information on a folder saved to a 

server.
Page 57 Branch Management

Revision graph A branch source folder and a folder duplicated by creating a branch can be 
displayed in a tree structure.

Linking with tools Tools for editing can be started in iQ AppPortal. Page 43 Editing an object

 When changing a folder name in iQ AppPortal, the corresponding one in a 
work area is also changed.

Page 85 Folder configuration in a work area

Item Description Reference
Classification Up to 100 classifications can be created. Page 35 Searching by a classification

"AND" or "OR" can be selected for searching by classifications.

Import and export Folders can be imported or exported in a batch. Page 69 Import and Export of Objects

RT ToolBox3 Workspaces created in RT ToolBox3 can be registered and managed. 

Registering and saving 
objects

• Up to 200 objects can be registered in one folder.
• Up to 10,000 folders and objects can be saved to a server in total.

Page 23 Object Registration/Save/Deletion

Display speed The display speed in the object list area is increased by enabling caching. Page 49 Increasing the display speed in the 
object list area

Item Description Reference
Operating system Windows 10 IoT Enterprise 2016 LTSB and Windows Server 2016 

(Standard and Essentials) are supported.
iQ AppPortal Installation Instructions

Data storage destination Up to 100 data storage destinations can be created in one server. Page 16 Data Storage Destination/Work Area 
Setting

Repository A repository is displayed in the data storage destination/work area setting 
area.

Page 20 Screen Configuration

Comment Up to 2,000 characters can be entered in a comment. Page 26 Saving an object

Retaining search conditions The object list area can be displayed with a condition specified for a search 
retained even when restarting iQ AppPortal.

Page 32 Object Search

Revision graph Folders can be expanded and collapsed for each layer in the revision graph. Page 61 Layer display switching
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Version 1.14Q

Version 1.17T

Version 1.20W

Version 1.23Z

Version 1.26C

Item Description Reference
Revision graph The history list and revision details can be displayed in the "Revision Graph" 

screen.
Page 63 Revision refinement

Item Description Reference
Verification Changes in an object can be checked by verifying the object. Page 64 Verification

Hiding read-only attribute 
folders

Read-only attribute folders can be hidden. Page 84 Hiding read-only attribute folders

Item Description Reference
Revision graph • The display speed in the change object list is increased in the "Revision 

Graph" screen.
• Revisions for a verification source and destination are displayed in 

different background colors in the "Revision Graph" screen.

Page 57 Branch Management
Page 64 Verification

Item Description Reference
GX Developer Projects created in GX Developer can be registered and managed. 

Folder format object Folders can be registered and managed as folder format objects. Page 79 Folder format object

Verification Objects other than those of MELSOFT products can be verified by using an 
external tool.

Page 64 Verification
Page 87 Setting an external tool used for 
verification

Item Description Reference
Server specifications • The version of VisualSVN Server is updated from 3.4.2 to 4.3.3.

• The connection method for VisualSVN Server is changed from HTTP to 
HTTPS.

Page 75 Server specifications for using iQ 
AppPortal

Verification Any two objects can be verified. Page 22 Menu List
Page 64 Verifying two objects

Search The following operations can be performed when refining objects:
• Registering a new object
• Registering an additional object
• Moving an object
• Importing an object
• Creating a branch


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Version 1.29F

Version 1.32J

Version 1.38Q

Item Description Reference
Operating system The following operating systems are supported:

• Windows 11
• Windows Server 2022
• Windows Server 2019

iQ AppPortal Installation Instructions

Server specifications The version of VisualSVN Server is updated from 4.3.3 to 4.3.7. Page 76 Version 1.26C or later

Object list area Objects can also be listed. Page 20 Screen Configuration
Page 22 Menu List

Application tree area Folder and object names are displayed in up to two lines. 

Revision graph • Folder names are displayed in up to two lines.
• The width of the "Revision No." column can be adjusted.
• The width of the change object list can be adjusted by using the 

separator.

Revision details display
Revision verification result

• Folder names are displayed in up to two lines.
• The width of the change object list can be adjusted by using the 

separator.

Item Description Reference
Operating system The following operating systems are no longer supported:

• Windows 8
• Windows 7
• Windows Server 2008 R2

iQ AppPortal Installation Instructions

Server specifications The version of VisualSVN Server is updated from 4.3.7 to 5.0.3. Page 76 Version 1.26C or later

Editing property information Property information can be edited in the callout property. Page 18 Callout property option
Page 30 Editing in the callout property

Revision graph [selected 
folder]

Only revisions of a folder selected in the object list area or application tree 
area can be displayed.

Page 58 Displaying a revision graph

Item Description Reference
Operating system The following operating systems are no longer supported:

• Windows 8.1
• Windows Server 2012 R2

iQ AppPortal Installation Instructions

Classification The names of classifications added to folders and objects can be displayed 
in the object list area.

Page 18 Classification option
Page 41 Classification name display

Up to 5000 classifications can be created. Page 37 Adding a classification

Classification types can be set. Page 38 Classification type setting

The display positions of classifications can be set. Page 39 Display position setting for each 
classification

Object icon display setting The icon color of an object other than one of MELSOFT products can be set 
for each extension.

Page 19 Object icon display setting
Page 50 Setting the icon colors of objects

Object list area The display order of folders and objects is retained even after ending iQ 
AppPortal.


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Appendix 2 Specifications of iQ AppPortal
This section shows the specifications and restrictions of iQ AppPortal.

Server specifications for using iQ AppPortal
The following shows the specifications of servers used for iQ AppPortal.

Version 1.23Z or earlier

*1 When installing iQ AppPortal in an environment where each product is already installed, the set port number is used.
*2 Runs as a service.

Use VisualSVN Server Manager to change the port number of VisualSVN Server.

Type Connection method Port number used*1 Others
VisualSVN Server 3.4.2 HTTP TCP: 61687 Root directory

C:\Repositories\
Repository name
iQAP
Service name*2

VisualSVN Server

PostgreSQL 9.4.6 HTTP TCP: 61689 Service name*2

• postgresql-9.4 (32-bit version)
• postgresql-x64-9.4 (64-bit version)

iQ AppPortal HTTP TCP: 61688 Service name*2

MELSOFT iQ AppPortal Service
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Version 1.26C or later

*1 When installing iQ AppPortal in an environment where each product is already installed, the set port number is used.
*2 Versions of VisualSVN Server used for each version of iQ AppPortal are as follows:

⋅ iQ AppPortal Version 1.26C: VisualSVN Server 4.3.3
⋅ iQ AppPortal Version 1.29F: VisualSVN Server 4.3.7
⋅ iQ AppPortal Version 1.32J or later: VisualSVN Server 5.0.3

*3 If VisualSVN Server is not installed or VisualSVN Server (evaluation) is installed before installing iQ AppPortal, the license type and 
authentication mode of VisualSVN Server are set as follows:
⋅ License type: Community (free)
⋅ Authentication mode: Subversion authentication

*4 When using a paid edition, iQ AppPortal can be used if the other specifications match.
*5 Runs as a service.

Use VisualSVN Server Manager to change the setting such as the port number or certificate for VisualSVN 
Server.

Restrictions
If VisualSVN Server is already installed before installing iQ AppPortal, specify the port number set for VisualSVN Server for 
"Port No." in the "Data Storage Destination/Work Area Setting" screen.

Type Connection method Port number used*1 Others
VisualSVN Server*2 HTTPS TCP: 61687 Root directory

C:\Repositories\
Repository name
iQAP
License type
Community (free)*3*4

Authentication mode
Subversion authentication*3

TLS/SSL compatibility level
Intermediate*1

Service name*5

VisualSVN HTTP Service

PostgreSQL 9.4.6 HTTP TCP: 61689 Service name*5

• postgresql-9.4 (32-bit version)
• postgresql-x64-9.4 (64-bit version)

iQ AppPortal HTTP TCP: 61688 Service name*5

MELSOFT iQ AppPortal Service
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Unusable character strings for iQ AppPortal
The following tables show the character strings that cannot be used for iQ AppPortal.

Precautions
The character strings are not case-sensitive.
A blank character (space) cannot be used before or after a character string; it is deleted.

Unusable character strings for a drive/path name

Unusable character strings for a folder name

*1 If used, iQ AppPortal may not run properly.

Category Character string
Invalid character (symbol) /, *, ?, ", <, >, |, ,, ;, and a period at the end of a name

Reserved device name CON, AUX, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4, 
LPT5, LPT6, LPT7, LPT8, LPT9, PRN, NUL, CLOCK$

Reserved word for MELSOFT Navigator $_CPRJ_$

Category Character string
Invalid character (symbol)*1 \, /, :, *, ?, ", <, >, |, ', %, ,, &, =, and a period at the end of a name

Reserved device name CON, AUX, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4, 
LPT5, LPT6, LPT7, LPT8, LPT9, PRN, NUL, CLOCK$

Reserved word for MELSOFT Navigator $_CPRJ_$

File name restriction by an operating system Character codes 0x00 to 0x1f
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Object configuration rules
When newly adding or updating a folder or object, the configuration of the object is displayed in the application tree area 
according to the following relationships:
 • Multiple objects can be placed in the same layer if their types are the same.
 • An object cannot be placed in the lower layer of a target object if its type is the same as the target one.
 • All objects other than those of MELSOFT products are placed in the second layer immediately under a folder.

Layer placement relationship of objects
: Placeable, : Not placeable

Parent-child relationship of objects
: Placeable, : Not placeable

Target Layer

1st layer 2nd layer 3rd layer 4th layer
Folder    

Workspace file    

Project file    

Other objects    

Upper layer Lower layer

Folder Workspace file Project file Other objects
Folder    

Workspace file    

Project file    

Other objects    
APPX
Appendix 2  Specifications of iQ AppPortal



A

Folder format object
A folder format object is one of objects managed in iQ AppPortal. Files other than those of MELSOFT products can be 
managed in a folder as one object.

Setting method of a folder format object
The following explains the method for registering a folder as a folder format object in iQ AppPortal.
To unify methods for registering a folder when multiple clients use one server, select the same item in the following setting 
among the clients.

Window
Select the [File] tab  [Option]  "Register."

Displayed items

Operating procedure
For registering a folder as a folder format object, select (1) and click the [OK] button.

Item Description
(1) Maintain Folder Configuration and Register it as 

Folder Format Object
A folder is registered as a folder format object.
It is registered as one object with the configuration maintained.

(2) Expand Folder and Register for Each File (Default) A folder is expanded and each object is registered.
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Registration image
The following shows images when registering a folder.
(1): When selecting "Maintain Folder Configuration and Register it as Folder Format Object"
(2): When selecting "Expand Folder and Register for Each File"

When registering only an object other than one of MELSOFT products
(1) (2)

Work Area Work Area

Project

Project
note.txt
project.xml
project_A.pdf
Project_A.pptx
project_A.xlsx

Project
Project##

Project
note.txt
project.xml
project_A.pdf
Project_A.pptx
project_A.xlsx

Project.iqap
Project.iqap

Project
Project##

note.txt
note.txt.iqap
project.xml
project.xml.iqap
project_A.pdf
project_A.pdf.iqap
Project_A.pptx
Project_A.pptx.iqap
project_A.xlsx
project_A.xlsx.iqap

Project.iqap
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When registering a folder that contains a project file of MELSOFT products
(1) (2)

Work Area Work Area

Project
project_A

project_A.gx3
Project_A.pptx
project_A.xlsx

project_B

note.txt
project.xml

project_B.xlsx
Project_B.pptx

Project
Project##
Project

Project.iqap
project_A.gx3
project_A.gx3.iqap

project_A

project_B

note.txt
project.xml

Project_A.pptx
project_A.xlsx

Project_B.pptx
project_B.xlsx

Project
Project##

Project.iqap
project_A.gx3
project_A.gx3.iqap

note.txt.iqap
note.txt

project.xml
project.xml.iqap
Project_A.pptx
Project_A.pptx.iqap
project_A.xlsx
project_A.xlsx.iqap
Project_B.pptx
Project_B.pptx.iqap
project_B.xlsx
project_B.xlsx.iqap
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Number of objects that can be registered in one folder format object
Up to 200 objects can be registered in one folder format object.
Data included or not in this number is as follows:
 • Object and MELSOFT iQ AppPortal information file (.iqap): Included.
 • Folder: Not included.

Precautions
The following table shows the considerations for operating and displaying a folder format object.

Operation and display Consideration
Registration
(Page 23 Registering an object)

• If there is any read-only attribute folder, hidden folder, or hidden file in a folder registered as a folder format 
object, it is registered as a normal folder or object.

• In addition, if there is any workspace file or project file of MELSOFT products in a folder registered as a folder 
format object, it is expanded and registered in the same layer as the folder format object.

Status display of an object
(Page 29 Status display of an object)

The status is displayed for each folder format object, not for each object in a folder format object. (Example: When 
adding an object to a folder format object, the object status of the folder format object changes to 'change.')

Edit
(Page 43 Editing an object)

When performing either of the following operations for a folder format object, the corresponding folder opens in 
Windows Explorer.
• Double-click an object.
• Right-click an object and select [Open From Program] from the shortcut menu.

Import
(Page 69 Importing objects)

If there is any workspace file or project file of MELSOFT products in a folder format object to be imported, it is 
expanded in the same layer as the folder format object, registered in iQ AppPortal, and saved to a server.
It is displayed in each screen for import as follows:
• Import list in the "Import" screen:

Data in the folder format object is not displayed. If there is any workspace file or project file of MELSOFT 
products in the folder format object, it is expanded and displayed in the same layer as the folder format object.

• Windows Explorer opened by right-clicking the folder format object in the import list in the "Import" screen and 
selecting [Open the Place of Object] from the shortcut menu:
Data in the folder format object is displayed. If there is any workspace file or project file of MELSOFT products in 
the folder format object, it is included and displayed in the folder of the folder format object.
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Read-only attribute folders
The following explains read-only attribute folders.

Read-only attribute folder types
When installing MELSOFT iQ AppPortal or FA Application Package iQ Monozukuri, the read-only attribute folder is 
automatically registered.

When registering these folders by dragging and dropping from the data obtained for installation, they are 
registered as normal folders.

Restrictions on a read-only attribute folder
The following table shows the restrictions on a read-only attribute folder.

Editing a read-only attribute folder
Read-only attribute folders do not exist in a work area, because the data is saved to a server only.
To edit a read-only attribute folder, the data must be acquired then re-registered in iQ AppPortal.
The following shows the procedure for re-registering a read-only attribute folder.

Operating procedure
1. Select a read-only attribute folder, and click the [Get the Latest Data] button.

2. Specify a folder different from the work area.

3. Drag and drop the generated folder onto iQ AppPortal.

When re-registering a read-only attribute folder, it is registered as a normal folder.

Type Description
ReadOnly Folder Registered by selecting the checkbox of "Sample Workspace" when installing MELSOFT iQ AppPortal.

iQ Monozukuri Folder Registered when installing FA Application Package iQ Monozukuri.

Item Description
Register The read-only attribute folder is registered when installing an application. Its type and name are displayed.

Copy The history is also retained when copying a read-only attribute folder in iQ AppPortal.
However, it is not retained when copying a read-only attribute folder in a work area.

Paste When a copy source is a read-only attribute folder, an object in the folder is pasted to a paste destination.
When copying an object in the read-only attribute folder and pasting it to an empty area in the object list area, a new folder is 
created in the same way as new registration.
The icon of the folder in the paste destination changes to the normal icon. (The type is a normal folder.)

Delete An object stored in a read-only attribute folder cannot be deleted.

Edit property information For a read-only attribute folder, only the property information can be browsed.
Property information cannot be edited or saved in the "Properties" screen.

Display the status of an object The object status is not displayed for a read-only attribute folder.

Acquire When acquiring the latest data, specify a different area from a work area.

Classify A classification cannot be added to an object in a read-only attribute folder.
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Hiding read-only attribute folders
Read-only attribute folders cannot be reserved for deletion. Hide them as necessary.

They can be hidden in the option setting.

Window
Select the [File] tab  [Option]  "Object 1."

Operating procedure
Unselect the checkbox of "Display the read-only attribute folder" under "Object Filtering," and click the [OK] button.

Maintaining the hidden state
Read-only attribute folders remain hidden even after uninstalling MELSOFT iQ AppPortal.
If read-only attribute folders are not displayed after reinstalling MELSOFT iQ AppPortal, select the checkbox of "Display the 
read-only attribute folder" to display.
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Restrictions on GX Developer, RT ToolBox3, and RT ToolBox2 
objects
The following restrictions apply to GX Developer, RT ToolBox3, and RT ToolBox2 objects in a workspace managed in 
MELSOFT Navigator:
 • Objects cannot be added to/changed in a workspace managed in MELSOFT Navigator.
 • Objects cannot be deleted from a workspace managed in MELSOFT Navigator.
 • Objects cannot be pasted to a workspace managed in MELSOFT Navigator.
 • Objects cannot be moved to/from a workspace managed in MELSOFT Navigator.
In addition, if there are multiple objects with the same workspace name among GX Developer, RT ToolBox3, or RT ToolBox2 
objects, the following restrictions apply:
 • Objects cannot be updated by dragging and dropping or by copying and pasting between workspaces with the same name.
 • Workspaces with the same name cannot be registered in the same layer.

Folder configuration in a work area
The following shows the folder configuration in a work area.

*1 For iQ AppPortal Version 1.01B or earlier, (New Folder (date and time)) is displayed for (folder name).

Folder name in a work area
For iQ AppPortal Version 1.04E or later, a folder name in a work area is the same as one created in iQ AppPortal.

Changing a folder name or file name in a work area
Even when changing a folder name or file name in a work area directly in Windows Explorer, etc., the change is not applied to 
the folder or object in iQ AppPortal.
A folder or file will no longer be managed in iQ AppPortal if its name is changed.
To manage it in iQ AppPortal, re-register it in iQ AppPortal.

Folder name/file name Stored file type Reference
(1) (Folder name)*1 A file that can be refined by the type under the smart filter Page 34 Objects that can be refined by the type

(2) (Folder name)##*1 A file other than the above 

(3) (Folder name)$$*1 An image added in the "Properties" screen Page 31 Image registration

(4) (Folder name).iqap*1 A MELSOFT iQ AppPortal information file (.iqap) Page 86 MELSOFT iQ AppPortal information file 
(.iqap)

Sample.pdf
Sample.pdf.iqap
Sample.txt
Sample.txt.iqap

WS000000.BMP

GXW3 sample.gx3
GXW3 sample.gx3.iqap
Navigator_sample.nvw
workspacelist.xml

New Folder New Folder##
New Folder$$

New Folder.iqap
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MELSOFT iQ AppPortal information file (.iqap)
A MELSOFT iQ AppPortal information file (.iqap) is a file with information on a folder and object (feature information of a 
project, the icon of an application, etc.).
It is saved to a server and work area with a folder and object.

Output method of a MELSOFT iQ AppPortal information file (.iqap)
Whether to output a MELSOFT iQ AppPortal information file (.iqap) can be set in "Setting for MELSOFT iQ AppPortal" in each 
MELSOFT product.
For the setting method of "Setting for MELSOFT iQ AppPortal," refer to the manual for each MELSOFT product.

Precautions
Do not change the name, configuration, or contents of a MELSOFT iQ AppPortal information file (.iqap).
If any of them is changed, the property information may not be displayed properly.

For a MELSOFT iQ AppPortal information file (.iqap) to which security such as access authority or a security 
key is set, only "Security" is displayed in the feature information of iQ AppPortal to prevent information 
leakage.

Versions of MELSOFT products used for verification
The following table shows the versions of MELSOFT products used for verification (Page 64 Verification).

For details on verification, refer to the following:
GX Works3 Operating Manual
GX Works2 Version 1 Operating Manual (Common)
GT Designer3 (GOT2000) Screen Design Manual

MELSOFT product Version
iQ AppPortal Ver.1.17T or later

GX Works3 Ver.1.025B or later

GX Works2 Ver.1.595V or later

GT Designer3 (GOT2000) Ver.1.235V or later
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Setting an external tool used for verification
The following explains the method for setting an external tool used to verify (Page 64 Verification) objects other than 
those of MELSOFT products.
An external tool refers to a tool other than a MELSOFT product.
The operation of WinMerge, which can compare folders and files, has been checked as an external tool used for verification.
Note that not all external tools are guaranteed to work with iQ AppPortal. Check the operation before use.

Ex.

The following shows a setting example when using WinMerge.
Command: C:\Program Files\WinMerge\WinMergeU.exe
Argument: /wl /wr /dl %sname /dr %dname %src %dst

Window
Select the [File] tab  [Option]  "Verify."

Displayed items

Item Description
(1) Command Enter the command (execution file path) of an external tool used for verification.

Up to 260 characters can be entered.

(2) Argument Enter a command argument defined in an external tool and a replacement parameter.
Up to 1024 characters can be entered.
Refer to the manual or help for the external tool as necessary.
• Replacement parameter

A replacement parameter is used to define an argument (the file path of a verification target, etc.), which requires a 
different value for each verification operation, as a parameter. It is replaced with the corresponding value by iQ 
AppPortal when verifying an object.

(3) [] button Click this to reference replacement parameters.
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Operating procedure
1. Enter the command (execution file path) of an external tool used for verification for "Command."

2. Enter a command argument defined in the external tool for "Argument."
Click the [] button to select and enter a replacement parameter*1.

3. Click the [OK] button.
*1 Each replacement parameter is replaced as follows when verifying an object.

Replacement parameter Content replaced when verifying an object
Source object (%src) Absolute paths to a folder and file of a verification source object.

• When verifying with the latest data: Path on a work area
• When setting an object selected in the object list area or application tree area as a verification source 

in the "Verify between Objects" screen: Path on a work area
• Other cases: Paths to a folder and file of a verification source object output to a temporary area

Destination object (%dst) • When setting an object selected in the object list area or application tree area as a verification 
destination in the "Verify between Objects" screen: Path on a work area

• Other cases: Absolute paths to a folder and file of a verification destination object output to a 
temporary area

Source object window display name (%sname) A display name of a verification source object in the window of an external tool

Destination object window display name (%dname) A display name of a verification destination object in the window of an external tool
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Appendix 3 Considerations
This section describes the considerations for iQ AppPortal.

When communication with iQ AppPortal is not allowed by 
Windows Firewall
When Windows Firewall is enabled and communication with iQ AppPortal is not allowed, a timeout may occur.
To allow the communication on a personal computer on which a server is installed, configure the setting by the following 
procedure.
When using other software with a firewall function, refer to the manual for the software and allow the communication with iQ 
AppPortal.

1. Select [System and Security]  [Windows Defender Firewall]  [Advanced settings] in the control panel of Windows.

2. Select [Inbound Rules]  [New Rule] in the "Windows Defender Firewall with Advanced Security" screen.

3. Select "Port" in [Steps:]  [Rule Type] in the "New Inbound Rule Wizard" screen.

4. Select "TCP" and "Specific local ports" in [Steps:]  [Protocol and Ports].

5. Enter '61688' in "Specific local ports," and click the [Next] button.

6. Select "Allow the connection" in [Steps:]  [Action], and check that all the checkboxes are selected in [Steps:]  [Profile].

7. Enter a name (example: MELSOFT iQ AppPortal) in "Name" and "Description" in [Steps:]  [Name], and click the 
[Finish] button.

The name (example: MELSOFT iQ AppPortal) is added to the list of "Inbound Rules" in the "Windows Defender Firewall with 
Advanced Security" screen.

Update from iQ AppPortal Version 1.00A
The configuration of a folder generated in a work area differs between iQ AppPortal Version 1.00A and iQ AppPortal Version 
1.01B or later.
Therefore, when re-registering a folder generated in a work area by using iQ AppPortal Version 1.00A in iQ AppPortal Version 
1.01B or later without changing the configuration, some data (files other than those of MELSOFT products, images added in 
the "Properties" screen, etc.) is not displayed properly on iQ AppPortal.
To display it properly on iQ AppPortal Version 1.01B or later, change the folder configuration by either of the following 
methods:
 • When updating the folder configuration in a work area to a new one
Update it in iQ AppPortal Version 1.00A. The folder configuration is automatically updated to a new one.
 • When changing the folder configuration outside a work area to a new one
Manually change it to the same folder configuration as that in the work area. (Page 85 Folder configuration in a work 
area)
Re-register it in iQ AppPortal Version 1.01B or later after changing to a new folder configuration.

Folders/files for system management
The following types of folders and files generated in a work area are for system management. Do not delete or move them.
 • MELSOFT iQ AppPortal information file (.iqap)
 • VisualSVN Server folder (.svn)
 • iQAPData file (iQAPData)

Subversion function
Subversion is built into iQ AppPortal.
To maintain the consistency of managed data, do not use the Subversion function for folders and objects in a work area.
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Appendix 4 Troubleshooting
This section explains the errors which may occur when using iQ AppPortal and their corrective actions.

*1 The Windows version can be checked by the following procedure:
 Enter "winver" in the search box of Windows, and select it from the menu.
 Check the version in the displayed screen.

*2 The display of iQ AppPortal will be blurred by enlarging.
The following lists the setting values for "Change the size of text, apps, and other items" and the recommended display resolution for 
each setting value in Windows 10 or later.
Setting value: 100%, display resolution: 1024 × 768 dots or more
Setting value: 125%, display resolution: 1900 × 1200 dots or more
Setting value: 150%, display resolution: 1900 × 1200 dots or more
Setting value: 175%, display resolution: 2880 × 1620 dots or more
Setting value: 200%, display resolution: 2880 × 1620 dots or more
Setting value: 225%, display resolution: 3840 × 2160 dots or more
Setting value: 250%, display resolution: 3840 × 2160 dots or more

*3 'IQAppPortal.exe' is stored in the folder where iQ AppPortal is installed.
The following are examples of storage locations.
64-bit version operating system: C:\Program Files (x86)\MELSOFT\iQAP\Client\IQAppPortal.exe
32-bit version operating system: C:\Program Files\MELSOFT\iQAP\Client\IQAppPortal.exe

Symptom Check point Corrective action
Contents in the screen are not 
displayed properly.
(For example, overlapping of icons, 
text overflowing from the frame of a 
button, etc.)

Is the size of the text and other items 
in the screen set to a value other than 
100% (96 DPI, 9 pt etc.) in Windows 
settings?

• Set the value to 100% (96 DPI, 9 pt etc.).
• For Windows 10 (version 1703 or later) or later*1, the display of iQ 

AppPortal can be displayed with high DPI scaling by using a function of the 
operating system.*2

 Select and right-click 'IQAppPortal.exe,'*3 then select [Properties] from the 
shortcut menu.
 Click the [Change high DPI settings] button in the [Compatibility] tab.
 Select the checkbox of "Override high DPI scaling behavior. Scaling 
performed by:," then select "System" from the pull-down list.
 Click the [OK] button.

Connection to a server fails when 
using iQ AppPortal Version 1.23Z or 
earlier.

• Is the connection method set to 
'https' in the communication setting 
for VisualSVN Server?

• Has iQ AppPortal Version 1.26C or 
later ever been installed?

Change the connection method to 'http' in the communication setting for 
VisualSVN Server.
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Appendix 5 Open Source Software
This section describes open source software and its license utilized for this product.

Entity Framework 6.1.3
Copyright  Microsoft Open Technologies, Inc. All rights reserved.
For details, refer to "MELSOFT\iQAP\Server\licenses\EntityFramework" in the folder in which this product has been installed.

Mono.Security 4.0.0.0

Npgsql 2.2.7, Npgsql for Entity Framework 2.2.7

PostgreSQL 9.4.6

Copyright  2001, 2002, 2003 Ximian, Inc and the individuals listed on the ChangeLog entries.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright  2002-2016, The Npgsql Development Team

Permission to use, copy, modify, and distribute this software and its documentation for any purpose, without fee, and without a written agreement is hereby 
granted, provided that the above copyright notice and this paragraph and the following two paragraphs appear in all copies.

IN NO EVENT SHALL THE NPGSQL DEVELOPMENT TEAM BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF 
THE NPGSQL DEVELOPMENT TEAM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE NPGSQL DEVELOPMENT TEAM SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND THE 
NPGSQL DEVELOPMENT TEAM HAS NO OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

PostgreSQL is Copyright  1996-2016 by the PostgreSQL Global Development Group.

Postgres95 is Copyright  1994-5 by the Regents of the University of California.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose, without fee, and without a written agreement is hereby 
granted, provided that the above copyright notice and this paragraph and the following two paragraphs appear in all copies.

IN NO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF 
THE UNIVERSITY OF CALIFORNIA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE UNIVERSITY OF CALIFORNIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS-IS" BASIS, AND THE 
UNIVERSITY OF CALIFORNIA HAS NO OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.
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SharpSvn 1.8
Copyright  2007-2012 The SharpSvn Project
For details, refer to "MELSOFT\iQAP\Client\licenses\SharpSvn" in the folder in which this product has been installed.

VisualSVN Server 5.0.3
Copyright  2022 VisualSVN Software Ltd. All rights reserved.
For details, refer to "VisualSVN Server\README.txt" in the installed folder.
For the license, visit the following:
Apache License Version 2.0: www.apache.org/licenses/LICENSE-2.0

zlib 1.2.8

MiniZip (included in zlib 1.2.8)

/* zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.8, April 28th, 2013

Copyright  1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this 
software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an 
acknowledgment in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly                          Mark Adler
jloup@gzip.org                           madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files http://tools.ietf.org/html/rfc1950 (zlib format), 
rfc1951 (deflate format) and rfc1952 (gzip format).*/

MiniZip - Copyright  1998-2010 - by Gilles Vollant - version 1.1 64 bits from Mathias Svensson

License
----------------------------------------------------------
Condition of use and distribution are the same than zlib :

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this 
software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an 
acknowledgment in the product documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.
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REVISIONS
*The manual number is given on the bottom left of the back cover.

Japanese manual number: SH-081622-N

 2016 MITSUBISHI ELECTRIC CORPORATION
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April 2022 SH(NA)-081623ENG-K Added or modified parts
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be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.
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INFORMATION AND SERVICES
For further information and services, please contact your local Mitsubishi Electric sales office or representative.
Visit our website to find our locations worldwide.

MITSUBISHI ELECTRIC Factory Automation Global Website
Locations Worldwide
www.MitsubishiElectric.com/fa/about-us/overseas/

TRADEMARKS
Microsoft and Windows are trademarks of the Microsoft group of companies.
Subversion is either a registered trademark or a trademark of the Apache Software Foundation in the United States and/or 
other countries.
The company names, system names and product names mentioned in this manual are either registered trademarks or 
trademarks of their respective companies.
In some cases, trademark symbols such as '' or '' are not specified in this manual.

COPYRIGHTS
The screens (screenshots) are used in accordance with the Microsoft Corporation guideline.
For the open source software used in this product, refer to the following:
Page 93 Open Source Software
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